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Date correctedDescriptionLocationPage

Offer page and 
back cover 
page

Publisher's Note: We apologize, but early printings of this book 
included information about a free Learning Plan Assessment, which is 
not available.

n/a

n/a Author's Note: Some customers have requested solution files for the 
practice exercises. Solution files are not available for the MOS 2010 
Study Guide but we'll take that into account for future editions.

n/a

Second 
paragraph

Author's Note: The URL is correct in some printings and out of date in 
others. It should read 
http://www.microsoftpressstore.com/title/9780735648753

xxv

"To move from 
page to 
page..." 
procedure, 
first line

Reads:
Click the Next Screen or Previous Screen button in the center of the 
title bar

Should read:
Click the Next Page or Previous Page button in the center of the title 
bar.

9/6/201310

Tip reader aid, 
second 
sentence

Reads:
You can select up to 5 pages down and 11 pages across by dragging 
through the grid.

Should read:
You can select many more pages by dragging through the grid. The 
number of pages you can select is dependent on your screen 
resolution.

2/1/201318

Second 
paragraph, 
fourth 
sentence

Author's Note: The sentence ("When more than two windows are 
stacked, the ribbon is hidden automatically.") is no longer valid and 
should be removed from the content.

20

Practice Tasks, 
second task, 
second 
sentence

Reads:
Then save the document.

Should read:
Wait one minute, and then save the document.

1/19/201529
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Last paragraph 
on page, 
second line

Reads:
...0.27 centimeters...

Should read:
...1.27 centimeters...

2/1/201359

"To create a 
new font set" 
procedure, 
step 3

Reads:
● In the Heading font list, click the font you want to use for all heading 
styles.
● In the Body font list, click the font you want to use for all heading 
styles.

Should read:
● In the Heading font list, click the font you want to set as the default 
for all heading styles.
● In the Body font list, click the font you want to set as the default for 
styles other than heading styles.

89

Practice Tasks, 
third and 
fourth tasks

Reads:
● At the beginning of the WordArt document, insert Welcome Esther 
Valle! in WordArt style 16 with 44-point text.
● In the WordArt document, change the words Extra! Extra! into 
WordArt style 21, and change the color of the letters to orange with a 
red outline. Then set the spacing to Very Loose. Make the object two 
inches wider, and then apply Shadow style 7.

Should read:
● At the beginning of the WordArt document, insert Welcome Esther 
Valle! in a Gradient Fill WordArt Style with 44-point text.
● In the WordArt document, change the words Extra! Extra! Into a Fill 
WordArt style, and change the color of the letters to orange with a 
red outline. Make the object two inches wider, and then apply the 
perspective Diagonal Lower Left shadow style.

2/3/2012112

"To store a clip 
art object in 
the Clip 
Organizer" 
procedure

Author's Note: The Clip Organizer might have been modified since the 
publication of this book, causing it to be inconsistent with the steps 
provided. 

114

"To link text 
boxes..." 
procedure, 
step 2

Reads:
On the Text Box Tools Format contextual tab...    

Should read:
On the Drawing Tools Format contextual tab…

2/3/2012116

"To save a 
selected text 
box..." 
procedure, 
step 1

Reads:
On the Format contextual tab…

Should read:
On the Insert tab…

2/3/2012117
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Practice Tasks, 
third task, last 
sentence

Reads:
Then apply Shadow Style 1 to both boxes.

Should read:
Then apply an Offset Diagonal Top Right shadow to both boxes.

2/3/2012117

"To move by 
one cell" 
procedure, 
third and 
fourth bulleted 
items

In the third list item, reads:
...Left Arrow key...

Should read:
...Right Arrow key...

In the fourth list item, reads:
...Right Arrow key...

Should read:
...Left Arrow key...

7/15/2011166

Practice Tasks, 
first task

Reads:
Configure the SalesByCategory worksheet of the PrintArea workbook 
so that printing with the default settings will print only columns B and 
C with gridlines.

Should read:
Configure the SalesByCategory worksheet of the PrintArea workbook 
so that printing with the default settings will print only columns B and 
C, and will print gridlines.

175

"To add a 
command to a 
custom group" 
procedure, 
step 3

Reads:
3. In the Choose commands pane, locate and double-click the 
command.

Should read:
3. In the Choose commands pane, click the command. Then click the 
Add button.

7/15/2011179

"To display 
properties in a 
browsing 
dialog box" 
procedure, 
step 2

Reads:
2. If the Tags property is not displayed, right-click any column 
heading, and then click Tags.

Should read:
2. Right-click any column heading, and then click the property you 
want to display.

7/15/2011184
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Practice Tasks, 
second and 
third tasks

Second bulleted item reads:
...on the Ad Buy Constraints worksheet.

Should read:
...on the Ad Buy Constraints worksheet into the new worksheet.

Third bulleted item reads:
Move the Cost Per Ad data to the left of the Total Cost cells.

Should read:
Move the Cost Per Ad data so that it is immediately to the left of the 
Total Cost cells.

2/3/2012192

See Also 
reader aid

Reads:
...in the Excel Help topic "Create or delete a custom number format."

Should read:
...in the Excel Help topic "Create a custom number format."

9/6/2013212

Practice Tasks, 
fourth task, 
first sentence

Reads:
On the Expense Statement worksheet of the RowColumnFormatting 
workbook, and set the entire worksheet so that all entries wrap in 
their cells.

Should read:
In the RowColumnFormatting workbook, configure the content of the 
Expense Statement worksheet so that all entries wrap in their cells.

214

Practice Tasks, 
first task

Reads:
...row and column titles…

Should read:
…row and column headings…

2/3/2012218

"To unhide the 
first row or 
column of a 
worksheet" 
procedure, 
step 1

Reads:
In the Name box to the left of the Formula Bar, enter , and then press 
Enter.

Should read:
In the Name box to the left of the Formula Bar, enter A1, and then 
press Enter.

219

Practice Tasks, 
first task, 
second 
sentence

Reads:
...contents will print horizontally on two pages of letter-size paper.

Should read:
…contents will print in a landscape orientation on two pieces of letter-
size paper.

2/3/2012222
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Practice Tasks, 
first task

Reads:
In the SalesReport workbook, and make a copy of the By Product 
worksheet.

Should read:
In the SalesReport workbook, make a copy of the By Product 
worksheet.

9/6/2013227

"To define a 
selected cell..." 
procedure, 
bulleted item

Reads:
In the Name box at the right end of the Formula Bar,…

Should read:
In the Name box at the left end of the Formula Bar,…

9/6/2013248

Practice Tasks, 
first and 
second tasks

Reads:
• On the Product Sales worksheet of the CellRange workbook, in cells 
C95, C101, and C104, calculate the sales total for each category by 
using a relative cell range reference.
• In cell C86 of the Product Sales worksheet, calculate the Cacti sales 
total by using an absolute cell range reference.
Should read:
• On the worksheet in the CellRange workbook, complete the 
following tasks:
   o In cells C95, C101, and C104, calculate the sales total for each 
category by using a relative cell range reference.
   o In cell C86, calculate the Cacti sales total by using an absolute cell 
range reference.

251

Procedure 
continued 
from previous 
page, Step 2

Reads:
In the Size and Properties dialog box…

Should read:
On the Size page of the Format Chart Area dialog box…

9/6/2013259

"To delete a 
shape from a 
SmartArt 
diagram" 
procedure

Reads:
Click the shape, and then press the Delete key.

Should read:
Click the shape's border, and then press the Delete key.

7/15/2011266

Practice Tasks, 
second task, 
last sentence

Reads:
Then apply the Powdered style…

Should read:
Then apply the Powder style…

7/15/2011270

Practice Tasks, 
first task

Reads:
On the Budget worksheet...insert a stylized budget clip art image…

Should read:
On the My Monthly Budget worksheet…insert a clip art image that has 
a budget-related keyword…

2/3/2012270
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Tip reader aid Reads:
Release the mouse button first, and then the Ctrl key. (If you release 
Ctrl first, Word will move the image instead of copying it.)

Should read:
Release the mouse button first, and then the Ctrl key. (If you release 
Ctrl first, Excel will move the image instead of copying it.)

7/15/2011272

Practice Tasks, 
first and 
second tasks

Reads:
● In the Sorting workbook, sort the data range on the 
SalesByCategory worksheet by Category.
● Sort the data range on the SalesByCategory worksheet by Category 
and then Price.

Should read:
● In the Sorting workbook, sort the data range on the 
SalesByCategory worksheet by Category only.
● Sort the data range on the SalesByCategory worksheet by Category 
and then by Sales.

2/3/2012295

Tip reader aid, 
middle of 
second line

Reads:
...items with left-pointing arrows display a gallery or menu when 
clicked.
Should read:
…items with right-pointing arrows display a gallery or menu when 
clicked.

7/15/2011312

Third bulleted 
item

Reads:
...legal-size paper...

Should read:
...ledger-size paper...

9/6/2013324

"To switch to 
Slide Master 
view" 
procedure

Reads:
...in the Presentation Views group…

Should read:
…in the Master Views group…

2/1/2013343

"To change the 
character 
spacing of 
selected text" 
procedure

Author's Note: If the Character Spacing button is unavailable, click the 
Font dialog box launcher , and then in the Font dialog box, click the 
Character Spacing tab to display that page.

348

"To change the 
case of 
selected text" 
procedure

Reads:
...click the Case button,…

Should read:
…click the Change Case button,…

2/1/2013348
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Procedure 
continued 
from previous 
page, Step 4

Reads:
...and in the Insert Picture dialog box,…

Should read:
…and in the Picture Bullet dialog box,…

2/1/2013353

"To apply a 
fancier 
animation..." 
procedure, 
steps 1 and 2

Reads:
1. On the Animations tab, in the Advanced Animation group, click the 
More button to the right of the Animation gallery, and then at the 
bottom of the gallery, click the animation category you want.
2. In the Change <Animation> Effect dialog box, click the animation 
you want.

Should read:
1. On the Animations tab, in the Animation group, click the More 
button. At the bottom of the Animation menu, click More <Animation 
Category> to display a list of animations in that category.
2. In the Change <Animation Category> dialog box, click the 
animation effect you want.

9/6/2013424

Practice Tasks, 
third task

Reads:
On slide 6, erase the line under the word customer. Then highlight the 
word instead.

Should read:
On slide 6, erase the line under the word customer, and then highlight 
the word.

470

"To change the 
space 
allocated to 
the navigation 
buttons" 
procedure, 
first bullet

Author's Note: To display the move handle, point to the line that 
divides the Navigation Pane and the navigation button area.

521

1st Step 1 Reads:
1. Position the cursor in the pane where you want the picture to 
appear.

Should read:
1. Position the cursor in the pane where you want the chart to appear.

554

The procedure 
"To cancel 
recurrence of a 
Calendar 
item," step 3

Author's Note: Cancelling the recurrence removes all past and future 
recurring instances of the appointment. To retain past occurrences, 
set the End By date to the current date.

609
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"Medium 
Detail" 
bulleted item

Reads:
Displays events and shaded, unlabeled bars to indicate ppointments 
and meetings.

Should read:
Displays events and shaded, unlabeled bars to indicate appointments 
and meetings.

622
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